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Preface
■ Introduction
This guide describes the product information, technical data, mechanical installation,
electrical installation, configuration, commissioning, and troubleshooting of the
product.

■ Standards Compliance
The following table lists the certifications, directives, and standards that the product
may comply with. For details about the acquired certificates, see the certification
marks on the product nameplate.

Certifica-
tion

Directive Standard

CE
Certifica-
tion

EMC Directive 2014/30/EU 24 VDC products
EN 61131-2
220 VAC products
EN 61131-2
EN 61000-3-2
EN 61000-3-3

LVD 2014/35/EU EN 61010-1
EN 61010-2-201

RoHS Directive 2011/65/EU
amended by (EU)
2015/863

EN IEC 63000

UL/cUL
Certifica-
tion

- UL 61010-1
UL 61010-2-201
CAN/CSA-C22.2 No. 61010-1
CSA C22.2 NO. 61010-2-201

KCC
Certifica-
tion

- -

EAC
Certifica-
tion

- -
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Certifica-
tion

Directive Standard

UKCA
Certifica-
tion

Safety
Regulations

Electrical
Equipment (Safety)
Regulations 2016

EN 61010-1
EN 61010-2-201

EMC
Regulations

Electromagnetic
Compatibility
Regulations 2016

24 VDC products
EN 61131-2
220 VAC products
EN 61131-2
EN 61000-3-2
EN 61000-3-3

RoHS
Regulations

Directive (RoHS)
Regulations 2012

EN IEC 63000

■ Revision History

Date Version Description

April 2024 A00 Initial release

■ How to Obtain
This guide is not delivered with the product. You can obtain the PDF version by the
following methods:

● Do keyword search under Service and Support at http://www.inovance.com.
● Scan the QR code on the product with your smart phone.

● Scan the QR code below to install the app, where you can search for and
download manuals.

www.inovance.com
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■ Warranty Disclaimer
Inovance provides warranty service within the warranty period (as specified in your
order) for faults or damage that occur during normal operation. Maintenance will be
charged after the warranty expires.

Within the warranty period, maintenance fee will be charged for the following
damage:

● Damage caused by operations not following the instructions in the user guide

● The product is damaged due to fire, flood, and abnormal voltage.

● Damage caused by unintended use of the product
● Damage caused by use beyond the specified scope of application of the product

● Damage or secondary damage caused by force majeure (natural disaster,
earthquake, and lightning strike)

The maintenance is charged according to the latest Price List of Inovance. If otherwise
agreed upon, the terms and conditions in the agreement shall prevail.

For details, see Product Warranty Card.
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Fundamental Safety Instructions
■ Safety Precautions
1. Before installing, using, and maintaining this equipment, read the safety

information and precautions thoroughly, and comply with them during operations.
2. To ensure personal and equipment safety, observe the notes indicated on the

product labels and all the safety instructions in the user guide.
3. "CAUTION", "WARNING", and "DANGER" in the user guide only indicate some of the

precautions that need to be followed; they just supplement the safety precautions.
4. Use this equipment according to the designated environment requirements.

Damage caused by improper use is not covered by warranty.
5. Inovance shall take no responsibility for any personal injury or property damage

caused by improper use.

■ Safety Levels and Definitions

 "DANGER” indicates that failure to comply with the notice can result in severe
personal injury or even death.

 "WARNING" indicates that failure to comply with the notice may result in
death or severe personal injury.

 
"CAUTION” indicates that failure to comply with the notice may result in
minor or moderate personal injury or equipment damage. Keep this manual
properly for future use and deliver it to the end user.

Control System Design

 

● Provide a safety circuit outside the PLC so that the control system can still work safely
once external power failure or PLC fault occurs.

● Add a fuse or circuit breaker because the module may smoke or catch fire due to long-
time overcurrent caused by operation above rated current or load short-circuit.
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● An emergency stop circuit, a protection circuit, a forward/reverse operation interlocked
circuit, and a upper position limit and lower position limit interlocked circuit must be set
in the external circuits of PLC to prevent damage to the machine.

● To ensure safe operation, for the output signals that may cause critical accidents, please
design external protection circuit and safety mechanism.

● Once the CPU of the PLC detects an exception in the system, all outputs may be closed;
however, when a fault occurs in the controller circuit, the output may not be under
control. Therefore, it is necessary to design an appropriate external control circuit to
ensure normal operation.

● If the PLC output units such as relays or transistors are damaged, the output may fail to
switch between ON and OFF states according to the commands.

● The PLC is designed to be used in an indoor electrical environment (overvoltage category
II). The power supply must have a system-level surge protector, assuring that overvoltage
due to lightning shock can't be applied to the PLC's power supply input terminals, signal
input terminals and output terminals, to prevent damage to the equipment.

Installation

 

● Installation must be carried out by specialists who have received the necessary electrical
training and understood enough electrical knowledge.

● Disconnect all external power supplies of the system before removing/installing the
module. Failure to do so may result in electric shock, module fault or malfunction.

● Do not use the PLC where there are dust, oil smoke, conductive dust, corrosive or
combustible gases, or exposed to high temperature, condensation, wind & rain, or
subject to vibration and impact. Electric shock, fire and malfunction may also result in
damage or deterioration to the product.

● The PLC is open-type equipment that must be installed in a control cabinet with lock
(cabinet housing protection > IP20). Only the personnel who have received the necessary
electrical training and understood enough electrical knowledge can open the cabinet.
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● Prevent metal filings and wire ends from dropping into ventilation holes of the PLC
during installation. Failure to comply may result in fire, fault and malfunction.

● Ensure there are no foreign matters on ventilation surface. Failure to comply may result
in poor ventilation, which may cause fire, fault and malfunction.

● Ensure the module is connected to the respective connector securely and hook the
module firmly. Improper installation may result in malfunction, fault or fall-off.

Wiring

 

● Wiring must be carried out by personnel who have received the necessary electrical
training and understood enough electrical knowledge.

● Disconnect all external power supplies of the system before wiring. Failure to comply
may result in electric shock, module fault or malfunction.

● Perform good insulation on terminals so that insulation distance between cables will not
reduce after cables are connected to terminals. Failure to comply may result in electric
shock or damage to the equipment.

 

● To avoid electric shock, cut off the power supply before connecting the product to the
power supply.

● The input power of the product must meet the specifications listed in this guide. If the
power input does not meet the specifications, the equipment may be damaged. Thus,
check regularly that the DC power provided by the switching-mode power supply unit is
stable.

Operation and Maintenance

 

● Maintenance & inspection must be carried out by personnel who have the necessary
electrical training and experience.

● Do not touch the terminals while the power is on. Failure to comply may result in electric
shock or malfunction.

● Disconnect all external power supplies of the system before cleaning the module. Failure
to comply may result in electric shock.

● Disconnect all external power supplies of the system before removing the module or
connecting/removing the communication wirings. Failure to comply may result in electric
shock or malfunction.
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Safety Recommendations

● In the position where the operator directly contacts the machinery part, for example,
where a machinery tool is loaded/unloaded, or where a machine runs automatically, the
onsite manual operating devices and any other alternative means must be carefully
arranged and designed so that they are independent of the programmable controller and
can start or terminate the automatic running of the system.

● If you need to modify the program while the system is running, use the lock function or
other protective measures. Ensure that only authorized personnel can make the
necessary modifications.

Disposal

 

● Dispose of retired batteries as industrial waste according to local laws and regulations.
● Recycle retired equipment by observing industry waste disposal standards to avoid
environmental pollution.
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1 Product Information

1.1 Product Introduction

■ Overview
GL20-RTU-EIP communication interface module connects to the EtherNet/IP network
as an EtherNet/IP slave. With this module, you can expand the system with Inovance
local modules such as GL20 series digital modules, analog modules, and temperature
detection modules ( "1.6 Release Notes" on page 14). It can be used together with
Inovance or third-party EtherNet/IP master devices.

■ Bus Current Consumption Calculation
The GL20-RTU-EIP module supports up to 16 GL20 series expansion modules,
including the GL20-PS2 module. The number of expansion modules supported
depends on the total bus current consumption.

When the total bus current consumption of the expansion modules ( "1.6 Release
Notes" on page 14) exceeds the bus supply current of the GL20-RTU-EIP module, that
is, 2 A, it is necessary to add an GL20-PS2 module to supply power to the expansion
modules.

The formula for calculating the total bus current consumed by the expansion
modules is as follows:
Total bus current consumption of expansion modules = Bus consumption current of
expansion module #1 + Bus consumption current of expansion module #2 + ... + Bus
consumption current of expansion module #n
● When a GL20-PS2 module is not provided, it is required that the total bus current

consumption of the expansion modules must not exceed 2 A.
For example, the GL20-RTU-EIP module can support up to 8 GL20-3232ETN-M
modules each with a bus current consumption of 250 mA (2 A/250 mA=8), or up to
16 GL20-0008ETP modules each with a bus current consumption of 85 mA (16 x 85
mA=1360 mA≤2 A).

● When a GL20-PS2 module is provided because the total current consumption of
the expansion modules that are directly powered by the GL20-RTU-EIP module
exceeds 2 A, the excessive expansion modules are powered by the GL20-PS2
module. The number of expansion modules supported by the GL20-PS2 module is
determined based on the total bus current consumption of the expansion
modules, similar to the above calculation method of the GL20-RTU-EIP module. It
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should be noted that if one GL20-PS2 module is provided, then its bus current
consumption must be included in the total supply current of the GL20-RTU-EIP
module. If multiple GL20-PS2 modules are provided, the bus current consumption
of a certain GL20-PS2 module must be included in the total supply current of the
immediately previous GL20-PS2 module.
For example, given that 8 GL20-3232ETN-M modules are already added to the
GL20-RTU-ECT module. If you want to add more expansion modules, a GL20-PS2
module is required for additional power supply. In this case, you need to remove
at least one GL20-3232ETN-M module to reserve the bus supply current margin of
the GL20-RTU-EIP module to supply power to the GL20-PS2 module. The GL20-PS2
module consumes a bus current consumption of 60 mA and provides a bus current
of 2 A.
Here we take one GL20-RTU-EIP module (2 A power supply) + one GL20-PS2 (2 A
power supply) + several GL20-3232ETN-M modules as an example, then at least 15
GL20-3232ETN-M can be supported (15 x 250 mA=3750 mA).

The following figure shows the power supply diagram of the GL20-RTU-EIP module.

● The GL20-PS2 module and the GL20-RTU-EIP module must be powered on
simultaneously, otherwise addressing may fail.

● Do not place the GL20-PS2 module in the last slot of the configuration.
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1.2 Model Number and Nameplate

① Product Information
GL: General local module

③ I/O Type
RTU: Remote terminal unit

② Series Number
20: 20 series module

④ Module Type
EIP: EtherNet/IP

The data for ordering the product is shown below.
Model Description Product

Code
Applicable Model

GL20-RTU-EIP GL20 series EtherNet/IP
communication module 01440511 Ethernet/IP master:

PLC
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1.3 Components

No. Interface Description

① Signal
indicator

PWR Power
indicator

ON Power supply normal

OFF Power supply abnormal

RUN
Running
state
indicator

Blinking EIP connection not established

Steady ON EIP connection established

ERR

Communi-
cation
error
indicator

Blinking
Blinking red at an interval of 1s,
indicating that a recoverable fault
such as RPI timeout occurs.

Steady ON
An unrecoverable fault such as
Ethernet hardware initialization
failure occurs.

SF
Applica-
tion fault
indicator

OFF The module has no fault.

Blinking The module has a minor hardware
fault, such as disconnection.

Steady ON

The module has a serious
hardware fault (such as module
hardware error, channel fault,
overlimit, etc.)

② Type-C
interface

Used for software upgrade of the board
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No. Interface Description

③ EtherNet/IP
interface

Ethernet port

④
24 V power
supply For power supply input

⑤ DIP switch Configure the IP.

1.4 Product Dimensions
The mounting dimensions (in mm) are shown in the figure below.

■ Module

■ End Cover
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1.5 Spare Parts and Options

■ Communication Cable
EtherNet/IP bus communication adopts shielded Ethernet cables for data
transmission, without short circuit, misalignment and poor contact. The length of
cables between devices cannot exceed 100m; otherwise, signal attenuation will occur
and affect normal communication. It is recommended to use cables specified as
follows.

Item Specification

Cable type Elastic crossover cable, S-FTP, Cat5

Standard
EIA/TIA568A, EN50173, ISO/IEC11801
EIA/TI Abulletin TSB, EIA/TIA SB40-A&TSB36

Cross sectional area 26AWG

Conductor type Twisted pair

Number of pairs 4

■ Power Supply Wiring
The cable lug and cable diameter described in the following table are only for
reference.

Material
Name

Cable Diameter KST Suzhou Yuanli
mm2 AWG Model Crimping

Tool
Model Crimping

Tool

Tubular
lug

0.3 22 E0308

KST2000L

0308

YAC-5

0.5 20 E0508 0508

0.75 18 E7508 7508

1.0 18 E1008 1008

1.5 16 E1508 1508

If you use other types of tubular lug, crimp the lug to the cables according to the
shape and dimension requirements shown in the figure below.
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■ External Interface Specifications

Type Interface
Cable Type/
Maximum
Length

Description User
terminals

Performance

EtherNet/IP
interface

EtherNet/IP
Cat5e
shielded
cable, 100 m

EtherNet/IP
communica-
tion interface

2x RJ45
100 Mbps
(100Base-TX)

Power supply 24 V input
3-core
unshielded
cable, 20 m

24 V power
input

6-pin
pluggable
terminal
block

24 V/1 A

1.6 Release Notes

The following describes the released firmware version, the matching expansion mod-
ules, and the matching EDS file version.

■ First release: 1.1.6.0 firmware (MCU)
● Matching expansion modules
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Product
Code

Module Name Description Firmware
Version

Bus
Current
Con-
sump-
tion

Input/Output
Size

01440293 GL20-0016ETN
16-channel DO
module (NPN
transistor)

Logic
software:
0.1.2.0 and
later

100 mA
Input: 0 byte
Output: 2
bytes

01440292 GL20-0016ETP
16-channel DO
module (PNP
transistor)

Logic
software:
0.1.2.0 and
later

85 mA
Input: 0 byte
Output: 2
bytes

01440291 GL20-1600END 16-channel DI
module

Logic
software:
0.1.2.0 and
later

100 mA
Input: 2 bytes

Output: 0
byte

01440287 GL20-4DA

4-channel DA
module,
supporting
voltage/current
output

Board
software:
1.1.5.0 and
later

100 mA
Input: 0 byte
Output: 8
bytes

01440288 GL20-4AD

4-channel AD
module,
supporting
voltage/current
output

Board
software:
1.1.5.0 and
later

100 mA
Input: 8 bytes

Output: 0
byte

01440489 GL20-8ADI

8-channel AD
module,
supporting current
output

Board
software:
1.1.0.5 and
later

100 mA

Input: 16
bytes

Output: 0
byte

01440482 GL20-8ADV

8-channel AD
module,
supporting voltage
output

Board
software:
1.1.0.5 and
later

100 mA

Input: 16
bytes

Output: 0
byte
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Product
Code

Module Name Description Firmware
Version

Bus
Current
Con-
sump-
tion

Input/Output
Size

01440334 GL20-0008ER 8-channel relay DO
module

Logic
software:
0.1.2.0 and
later

85 mA
Input: 0 byte
Output: 1

byte

01440381 GL20-0800END
8-channel digital
input module

Logic
software:
0.1.2.0 and
later

100 mA
Input: 1 byte
Output: 0

byte

01440379 GL20-0008ETN
8-channel DO
module (NPN
transistor)

Logic
software:
0.1.2.0 and
later

100 mA
Input: 0 byte
Output: 1

byte

01440380 GL20-0008ETP
8-channel DO
module (PNP
transistor)

Logic
software:
0.1.2.0 and
later

85 mA
Input: 0 byte
Output: 1

byte

01440339 GL20-0808ETN 8-channel DI/DO
module

Logic
software:
0.1.2.0 and
later

85 mA
Input: 1 byte
Output: 1

byte

01440290 GL20-3232ETN-M
32-channel DI/DO
module (ejector
header)

Board
software:
3.0.4.0 and
later

250 mA
Input: 4 bytes

Output: 4
bytes

01440378 GL20-3200END-
M

32-channel DI
module (ejector
header)

Board
software:
3.0.4.0 and
later

125 mA
Input: 4 bytes

Output: 0
byte

01440377 GL20-0032ETN-M
32-channel DO
module (ejector
header)

Board
software:
3.0.4.0 and
later

125 mA
Input: 0 byte
Output: 4
bytes
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Product
Code

Module Name Description Firmware
Version

Bus
Current
Con-
sump-
tion

Input/Output
Size

01440466 GL20-3200END
32-channel DI
module (push-in
terminal)

Logic
software:
0.1.2.0 and
later

85 mA
Input: 4 bytes

Output: 0
byte

01440467 GL20-0032ETN
32-channel DO
module (push-in
terminal)

Logic
software:
0.1.2.0 and
later

125 mA
Input: 0 byte
Output: 4
bytes

01440337 GL20-4PT

4-channel input
thermal resistor
temperature
detection module

Board
software:
2.0.5.0 and
later

100 mA

Input: 16
bytes

Output: 0
byte

01440338 GL20-4TC

4-channel input
thermocouple
temperature
detection module

Board
software:
2.0.5.0 and
later

85 mA

Input: 16
bytes

Output: 0
byte

01440351 GL20-PS2 2A power module

Board
software:
0.1.2.0 and
later

2000 mA
Input: 0 byte
Output: 0

byte

● Matching EDS file version: 00.01
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2 Product Specifications

2.1 Electrical Specifications

Item Specification

Rated terminal input voltage 24 VDC (20.4 VDC to 28.8 VDC)

Rated terminal input current 0.6 A (typical@24 V)

Rated bus output voltage 5 VDC (4.75 VDC to 5.25 VDC)

Rated bus output current 2 A (typical@5 V)

Power output derating 80% derating at 55°C (the output current does not exceed
1.6 A), or 10°C derating when output current is 2 A

2.2 Technical Specifications

■ General specifications

Item Specification

IP rating IP20

Dimensions (W x H x D) 24 mm x 100 mm x 83 mm

Weight Approx. 123 g

■ Software specifications

Item Specification

IP setting method
● USB software tool
● BOOTP/DHCP
● DIP switch

Network topology Linear, star, tree, and DLR (only supported as managed)

Max. number of supported I/
O modules 16

Max. data length Input: 504 bytes, Output: 504 bytes

Transmission distance 100 m

RPI 1 ms to 50,000 ms

Max. number of CIP
connections 8
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Item Specification

Network interface 2x RJ45 with interactive function

Connection rate 100M

■ Environmental Specifications

Item Specification

Operating environment No corrosive and flammable gas and no excessive
conductive dust

Altitude ≤2,000 m

Pollution degree 2

Noise immunity 2 kV on power supply line (Conforms to IEC 61000-4-4)

Overvoltage category I

EMC immunity level Zone B, IEC61131-2

Vibration resistance

● Operating: Tested according to IEC 60068-2-6. 5 Hz to 8.4
Hz, 3.5 mm, 8.4 Hz to 200 Hz, 1 g, 10 cycles each in X, Y
and Z directions.

● Transport: Tested according to IEC 60068-2-64. 5 Hz to 100
Hz, 0.01 g2/Hz; 200 Hz, 0.001 g2/Hz, 1.14 g, 30 min each in
X, Y and Z directions.

Shock resistance

● Operating: Tested according to IEC 60068-2-27. 15 g, 11
ms, 18 shocks.

● Transport: Tested according to IEC 60068-2-27. 15 g, 11
ms, 18 shocks.

Operating temperature/
humidity

● Temperature: -20°C to +55°C
● Relative humidity: 10% to 90% RH, non-condensing

Storage temperature/
humidity

● Temperature: -40°C to +70°C
● Relative humidity: <90% RH, non-condensing
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3 Mechanical Installation

3.1 Installation Precautions
● Before installing or removing the module, ensure that the module is powered off.

Do not hot swap the modules. Otherwise, the modules may be damaged by
overcurrent or overvoltage, and the PLC may be subject to restart, user data loss or
corruption.

● Prevent the enclosure or terminals of the module from dropping or suffering from
impact or shock.

3.2 Installation Method
The module is mounted onto a DIN rail in conformity with IEC 60715 (width: 35 mm,
thickness: 1 mm). The dimensions (unit: mm) are shown below.

If the module is not installed on the recommended DIN rail (especially when the DIN
rail thickness is not 1.0 mm), DIN rail buckles may not be locked. In this case, the
module cannot be installed in place and will fail to work properly.
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■ Installing the modules to each other
1. Remove the end cover in the direction indicated by the arrow, as shown below.

You can install multiple modules to each other with the help of top and bottom
guides on the modules, as shown below.

■ Installing the module onto DIN rail
1. Align the module with the DIN rail and push the module in the direction indicated

by the arrow until you hear a clicking sound, as shown below.
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2. Make sure the DIN rail mounting hook of the module is locked. The locked and
unlocked states of the mounting hook are shown below.

● If the mounting hook is pressed down, it is locked.

● If the mounting hook is lifted up, it is unlocked.

Press down the mounting hook to lock the module to the DIN rail.

When the module is not installed on the DIN rail, keep the rail buckles in locked state.
If the rail buckles remain in unlocked state for a long period of time, they will be
invalidated.

3. Mount an end plate on either side of the PLC or the module.
To mount the end plate, hook the bottom of it to the bottom of the DIN rail, rotate
the end plate to hook the top of it to the top of the DIN rail, and then tighten the
screw to lock the end plate in place.
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■ Removing the module
Pry the DIN rail mounting hook upwards with a tool such as slotted screwdriver, hold
the protrusions and pull the module out straight forward, and then press down the
top of the DIN rail mounting hook.



‑24‑

4 Electrical Installation

4.1 Cable Connection

Figure 4-1 Cable connection diagram (in mm)

Note
To ensure the reliability, it is recommended to use different power supply modules for
the 24 V input of the communication interface module and the 24 V input of other
modules.
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4.2 Electrical Wiring Diagram
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5 Programming Examples

5.1 IP Address Definition and Configuration

■ Configuring the IP address via DIP switch
The DIP switch of the GL20-RTU-EIP module provides eight bits, which are defined as
follows:

● When the DIP switch value is 0x00, the module uses the software-configured IP.
The software-configured IP can be configured using the USB configuration tool
(Note: The module comes with a factory default IP 192.168.1.66).

● When the DIP switch value is 0xFF, the module is in DHCP mode by default. In this
mode, the BOOTP tool must be used to assign IP every time the module is
powered on.

● When the DIP switch value is in the range 0x01 to 0xFE, the DIP switch value
represents the last byte of the IP address. The first three bytes can be configured
by the software or use the default (192.168.1). By default, the mask is
255.255.255.0 and the gateway is 192.168.1.1.

After modifying the IP address, it is necessary to restart the GL20-RTU-EIP module.

Positions of DIP switch (ON: 1, OFF: 0) Key value IP address
1 2 3 4 5 6 7 8

0 0 0 0 0 0 0 0 0x00

Software
configuration

mode
(Configura-
tion via USB)

1 0 0 0 0 0 0 0 0x01 x.x.x.1

0 1 0 0 0 0 0 0 0x02 x.x.x.2

. . . . . . . . . .

. . . . . . . . . .

0 1 1 1 1 1 1 1 0xFE x.x.x.254

1 1 1 1 1 1 1 1 0xFF DHCP mode

■ Software configuration mode
When all switches are 0, you can configure the IP address via software.
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In the software configuration mode, you can configure the IP address through a USB
connection.

Connect to the Type-C port of the GL20-RTU-EIP module through a USB cable, open
the USB tool, and enter the IP address, subnet mask, and gateway address. Click IP
and Mask Gateway Configuration to send the IP address to the module.

Figure 5-1 Configuring IP address via the USB tool

5.2 Configuration of Mounted Modules
The modules mounted to the GL20-RTU-EIP communication interface module can be
configured either through the USB configuration tool or through the attribute of
custom UCMM object.

5.2.1 Configuration via USB Configuration Tool
■ Prerequisite
The USB configuration tool has been successfully installed.

■ Steps
1. Check the configuration of modules mounted to the communication interface

module.
Connect to the communication interface module via the USB cable, open the USB
configuration tool, and click Connect Device. Upon successful connection, click
Upload Topology to view the configuration of the modules mounted to the
communication interface module. Right-click the communication interface module
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and select PDO Parameters to view the periodic data type and data length of
input and output of each module, and total data size of all modules.

Figure 5-2 Viewing the configuration of the modules mounted to the commu-
nication interface module

2. Configure the module.
Click a corresponding module in the module list, and then click the Parameter
Configuration tab. After configuring the configuration data of the module, click
Parameter Configuration in the lower left corner to send the module
configuration parameters to the communication interface module.
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Figure 5-3 Configuring the module

5.2.2 Configuration via UCMM Programming

The module supports UCMM (Unconnected Message Manager). You can obtain
configuration information, version number, diagnostic information, as well as issue
module configuration data by reading and writing custom UCMM objects.

■ Configuration Flowchart
The following figure shows the process of issuing configuration data through the
attributes of custom UCMM objects. First, read the attribute 0x00000064 of instance
0x00000000 of object 0x0381 of the communication interface module to obtain the
number of modules mounted to the EIP communication interface module and the ID
of each module. Then perform match according to the module type returned. After
the configuration interface is generated, generate the configuration data according to
the protocol format and allocate the configuration data to the corresponding slot.

Note
The diagnostic data can be read selectively based on actual requirements or read by
default.
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Figure 5-4 Configuration flowchart

■ Definition of UCMM communication protocol
● UCMM read/write definition:
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Class ID Instance Attribute Notes

0x0381

0x00000000 0x00000064
Communication interface module information,
including the number of modules mounted and
module ID

0x00000001

0x00000001 Module ID, module version

0x00000002 Configuration information

0x00000003 Diagnostic information

0x00000002

0x00000001 Module ID, module version

0x00000002 Configuration information

0x00000003 Diagnostic information

0x00000003

0x00000001 Module ID, module version

0x00000002 Configuration information

0x00000003 Diagnostic information

0x00000004

0x00000001 Module ID, module version

0x00000002 Configuration information

0x00000003 Diagnostic information

…… …… ……

0x00000010

0x00000001 Module ID, module version

0x00000002 Configuration information

0x00000003 Diagnostic information

● Definition of returned data for UCMM read:



‑32‑

Class ID Instance Attribute length data Notes

0x0381

0x00000000 0x00000064

Total
length
of the
data
area

Refer to table 5-1

Communication
interface module
information,
including the number
of modules mounted
and module ID

0x00000001

0x00000001 - Refer to table 5-2 Module ID, module
version

0x00000002 -
Refer to module
configuration
data

Configuration
information

0x00000003 -
Refer to module
diagnostic data

Diagnostic
information
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Class ID Instance Attribute length data Notes

0x0381

0x00000002

0x00000001 - Refer to table 5-2 Module ID, module
version

0x00000002 -
Refer to module
configuration
data

Configuration
information

0x00000003 -
Refer to module
diagnostic data

Diagnostic
information

0x00000003

0x00000001 - Refer to table 5-2 Module ID, module
version

0x00000002 -
Refer to module
configuration
data

Configuration
information

0x00000003 -
Refer to module
diagnostic data

Diagnostic
information

0x00000004

0x00000001 - Refer to table 5-2 Module ID, module
version

0x00000002 -
Refer to module
configuration
data

Configuration
information

0x00000003 -
Refer to module
diagnostic data

Diagnostic
information

…… …… …… …… ……

0x00000010

0x00000001 - Refer to table 5-2 Module ID, module
version

0x00000002 -
Refer to module
configuration
data

Configuration
information

0x00000003 -
Refer to module
diagnostic data

Diagnostic
information
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Table 5–1 Communication interface module information list
length data

data
Total
length
(2byte)

Commu-
nication
interface
module

ID
(4byte)

Commu-
nication
interface
module
version
(4byte)

FPGA
Version
(4byte)

Number of
slots

mounted
to the

communi-
cation

interface
module
(4byte)

Slot 1
Module

ID
(4byte)

Slot 2
Module

ID
(4byte)

……

Slot x
Module

ID
(4byte)

0xXXXX 0xXXXX-
XXXX

0xXXXX-
XXXX

0xXXXX-
XXXX

0xXXXXXX-
XX

0xXXXX-
XXXX

0xXXXX-
XXXX ……

0xXXXXX-
XXX

Table 5–2 Information list of local modules
length data -

Total data length
(2byte)

MCU version
(4byte)

Module ID
CPLD version

(4byte)

0xXXXX 0xXXXXXXXX 0xXXXXXXXX 0xXXXXXXXX

● Definition of UCMM RX/TX data:
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Class ID Instance Attribute data Notes

0x0381

0x00000000
0x00000064 - Not allowed to write

0x00000065 Tooling-related
functions -

0x00000001

0x00000001 - Not allowed to write

0x00000002
Refer to module
configuration data

Configuration
information

0x00000003 - Not allowed to write

0x00000002

0x00000001 - Not allowed to write

0x00000002
Refer to module
configuration data

Configuration
information

0x00000003 - Not allowed to write

0x00000003

0x00000001 - Not allowed to write

0x00000002
Refer to module
configuration data

Configuration
information

0x00000003 - Not allowed to write

0x00000004

0x00000001 - Not allowed to write

0x00000002
Refer to module
configuration data

Configuration
information

0x00000003 - Not allowed to write

…… …… …… ……

0x00000010

0x00000001 - -

0x00000002
Refer to module
configuration data

Configuration
information

0x00000003 - Not allowed to write

● Definition of returned data for UCMM write: Same with the standard format of the
returned data for UCMM write.

5.3 Definition of Process Data

■ Process data mapping
The network adapter reads and writes the I/O process data of the I/O module in real
time through the internal bus. The data mapping model is shown in the following
figure.
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Figure 5-5 Diagram of data mapping model
For the mapping of the input data for a specific cycle, you can view related
parameters in the USB software. The maximum input bytes and output bytes of the
EtherNet/IP network adapter are 504 bytes respectively.

■ Diagnostic Definition of Process Data
The GL20-RTU-EIP communication interface module itself outputs process data. The
first two bytes of the input process data are diagnostic data, such as Diag data on
“Figure 5–5 ” on page 36 .

bit Name Meaning Remarks

0 EIP diagnosis Indicates the EIP
diagnostic information

1: Diagnostic information
present

1 GL-LINK diagnosis Indicates the GL-LINK
diagnostic information

1: Diagnostic information
present

2 MODULE diagnosis Indicates the MODULE
diagnostic information

1: Diagnostic information
present

3 EIP STATUS EIP connection status 1: Connected, 0:
Disconnected

4 to 7 GL-LINK STATUS Status of local bus See below

8 to 15 MODULE Address
Address of the module
that has diagnostic
information.

If multiple modules have
diagnostic information,
then it is the address of the
last module.
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When the module has diagnostic information, bit2 is set to 1 and bit8 to bit15 displays
the address of the module with diagnostic information. When multiple modules have
diagnostic information, bit2 displays the address of the module with diagnostic
information. It is the address of the last module with diagnostic information.

Local bus status: 0: Error; 1: Initialization; 2: Pre-running; 3: Safe-operational; 4:
Running

For detailed diagnostic fault codes of the module, see " Fault Diagnosis" on page 61.

5.4 Programming Examples

5.4.1 Programming with Inovance InoProShop
■ Prerequisite
Inovance InoProShop software has been installed successfully and the EDS file is
ready. You can get the InoProShop software and the EDS file at https://www.
inovance.com.

■ Steps
1. Add a device.

a. Add EDS file of the GL20-RTU-EIP communication interface module.

Note
If the EDS file is not installed successfully, the GL20-RTU-EIP device cannot be
scanned.

1). In the menu bar, select Tools > Device Repository. The Device Repository
dialog opens, as shown below.

https://www.inovance.com
https://www.inovance.com
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Figure 5-6 Opening the device repository
2). In the menu bar, select Tools > Device Repository. The Device Repository

dialog opens, as shown below.
3). In the pop up dialog, open the EDS file of the GL20-RTU-EIP communication

interface module to be installed, as shown below.

Figure 5-7 Installing the EDS file
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b. Add the GL20-RTU-EIP communication interface module.

1). Double-click Network Configuration and select "EtherNet/IP Master", as
shown below.

Figure 5-8 Adding EtherNet/IP master
2). Add the GL20-RTU-EIP communication interface module through automatic

scanning or manual addition, as shown below.

● Automatic scanning

i. In the Devices pane, right-click "EtherNetIPMaster_A (EtherNet/IP Scanner)"

and select Scan for Devices.
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Figure 5-9 Scanning for device
ii. Click Scan Devices, select the scanned device, and click Copy all to project

to finish adding the GL20-RTU-EIP communication interface module

(Currently, the modules that are mounted to the communication interface

module cannot be added through scanning.)

Figure 5-10 Selecting the scanned device

● Adding the module manually

i. Right-click "EtherNetIPMaster_A (EtherNet/IP Scanner)" and select Add

Device.
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Figure 5-11 Adding device
ii. Click Add Device. In the pop up dialog, select the GL20-RTU-EIP

communication interface module.

Figure 5-12 Adding GL20-RTU-EIP communication interface
module
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2. Configure the EtherNet/IP network adapter.
In the Devices pane, double-click "EtherNet_A (EtherNet)". In the pop up page,
select the General tab and then click Interface to select the network adapter with
the same IP as the communication interface module.

Figure 5-13 Configuring EtherNet/IP

3. Configure the GL20-RTU-EIP communication interface module.

a. Configure the general information of the GL20-RTU-EIP communication interface
module.
In the Devices pane, select GL20_RTU_EIP (GL20-RTU-EIP) > General. Check
whether the IP address of the module is the IP address configured. If not, modify
the IP address.



‑43‑

Figure 5-14 Configuring the GL20-RTU-EIP communication interface
module

b. View modules connected to the GL20-RTU-EIP communication interface module.
Connect to the communication interface module via the USB cable, open the
USB software, and click Connect Device. Upon successful connection, click
Upload Topology to view the configuration of the mounted communication
interface module. Right-click the communication interface module and select
PDO Parameters to view the periodic data type and data length of input and
output of each module, and total data size of all modules.
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Figure 5-15 Viewing modules connected to the GL20-RTU-EIP
communication interface module

c. Configure the connection information of the GL20-RTU-EIP communication
interface module.
I/O data statistics are available in the host controller. For details, see "5.2.1
Configuration via USB Configuration Tool" on page 27. You can configure the
connection parameters of the GL20-RTU-EIP communication interface module
through I/O data statistics.

The OUT and IN byte statistics are known. In the Devices pane, go to GL20_
RTU_EIP (GL20-RTU-EIP) > Connections. Configure the input/output assembly
based on the type and channels of the module. For example, configure "O→T
Size" to 11 bytes and "T→O Size" to 11 bytes, as shown below.
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Figure 5-16 Configuring the connection of the GL20-RTU-EIP
communication interface module

d. Log in to and operate the GL20-RTU-EIP communication interface module.
Log in to InoProShop. In the Devices pane, select GL20_RTU_EIP (GL20-RTU-
EIP) > EtherNet/IP I/O Mapping, as shown below. You can operate the data of
the module.
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Figure 5-17 Logging in to and operating the GL20-RTU-EIP communication
interface module

Note
The bytes occupied by OUT and IN of each module are stored in sequence according
to the module ID, and can be displayed in the order of the dataset after the dataset is
established.

5.4.2 Programming with Omron Sysmac Studio
■ Prerequisite
The Omron Sysmac Studio software has been installed successfully.

■ Steps
1. Create a project.

a. Open the Sysmac Studio software, click New Project. In the Project Properties
dialog, select the device and click Create.
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Figure 5-18 Creating a project
b. In the left navigation pane, select Configurations and Setup > Controller

Setup > Built-in EtherNet/IP Port Settings to view the fixed IP address.

Figure 5-19 Viewing the fixed IP address
c. View the network segment of the PC.
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Figure 5-20 Viewing the network segment of the PC
d. After you set the PC to be on the same network segment as the PLC, click .

Then you can monitor the connection status and run mode. To switch the PLC
to the offline status, click .

Figure 5-21 Viewing the network segment of the PC
2. Configure the project.

a. Before carrying out EtherNet/IP communication, determine the input/output
data area size. You can configure the connection parameters of the GL20-RTU-
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EIP communication interface module by configuring "PDO Parameters" in
IOManger software.

Figure 5-22 Viewing the data statistics
b. Based on the input/output data area size of the I/O module, click Global

Variables to create an input variable (ARRAY[0..10] OF byte) and an output
variable (ARRAY[0..10] OF byte). Select "Input" and "Output" respectively in the
Network Public column.

Figure 5-23 Creating an input/output variable
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c. In the menu bar, select Tools > EtherNet/IP Connection Settings. In the pop up
dialog, double-click the PLC to open the Built-in EtherNet/IP Port Settings -
Connection Settings interface.

Figure 5-24 Built-in EtherNet/IP port settings - Connection settings
d. Click Register All, select the input/output variable defined by the global

variable, and click Register to complete the registration of the new variable.

Figure 5-25 Registering the variable
3. Import the EDS file

a. In the right Toolbox pane, right-click the space and select Display EDS Library
to open the EDS library.
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Figure 5-26 Displaying the EDS library
b. In the pop up window, click Install. Then in the pop up dialog, open the EDS file

of the GL20-RTU-EIP communication interface module to be installed. After
successful installation, the EDS library displays the Inovance logo.

Figure 5-27 Installing the EDS file
4. Add a configuration module.

a. In the right Toolbox pane, select Target Device and then click + to add a GL20-
RTU-EIP network configuration module.
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Figure 5-28 Adding a configuration module
b. In the right Toolbox pane, modify the node address to the IP address of the

communication interface module.

Figure 5-29 Modifying the node address
c. Click > , and select "192.168.250.20 GL20-RTU-EIP" for Target Device. Set

Originator Variable to "input" or "output". Set Target Variable to "101" for
input and "100" for output。 Ensure that the target variable and originator
variable have the same size (byte).
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Figure 5-30 Connection diagram
d. Select > in the function bar or select Controller > Transfer > To

Controller > Execute in the menu bar to complete the transfer.

Figure 5-31 Transfer diagram
e. In the menu bar, select View > Watch Tab Page to open the watch tab page.
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Figure 5-32 Opening the watch tab page
f. Add input/output variables in the watch tab page for data monitoring.

Figure 5-33 Data monitoring diagram

5.4.3 Configuration with Rockwell Studio5000
■ Prerequisite
The Rockwell Studio5000 software has been installed successfully.

■ Steps
1. Import the EDS file

Open the Studio5000 software, click TOOLS, and then import the EDS file of the
communication interface module.
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Figure 5-34 Importing the file
2. Configure the device.

In the left project tree, right-click Ethernet to add the configuration. In the pop up
dialog, search for GL20. The configuration description file of GL20 is displayed.
Click Create to create the configuration.
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Figure 5-35 Creating the configuration
3. Modify the configuration parameters.

a. In the left project tree, click the configuration to modify the input/output
parameters of the communication interface module.

b. Modify the configuration parameters based on the actual input/output byte size
of the communication interface module. With the correct IP address setting, you
can download the modifications to the PLC.



‑57‑

Figure 5-36 Modifying the parameters

5.4.4 Configuration with Keyence KV STUDIO
■ Prerequisite
The Keyence KV STUDIO software has been installed successfully.

■ Steps
1. Import the EDS file

After creating the project, double-click to enter the EIP configuration interface and
click EDS file to import the EDS file of the communication interface module.
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Figure 5-37 Importing the file
2. Configure the device.

Double-click the EDS file of the communication interface module to create the
configuration.
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Figure 5-38 Creating the configuration
3. Modify the configuration parameters.

a. Double-click "Exclusive Owner" of the connection to enter the configuration and
modify the input/output parameters of the communication interface module.

b. Modify the configuration parameters based on the actual input/output byte size
of the communication interface module. With the correct IP address setting, you
can download the modifications to the PLC.
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Figure 5-39 Modifying the parameters
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6 Fault Diagnosis
LED indicator Meaning Solution

RUN Blinking EIP connection not
established

● Check that the network parameters (IP
address, subnet mask, and gateway) are
configured correctly.

● Check the configured input/output data size
and the configuration parameters sent down
to the module.

● Check that the length and other specifications
of the network cable are as specified.

BF

Blinking
A recoverable fault
such as RPI timeout
occurs.

● Check that the cable connector is inserted
correctly.

● Check that the network connection is stable.

Steady
ON

An unrecoverable fault
such as Ethernet
hardware initialization
failure occurs.

● Check that the cable connector is inserted
correctly.

● Check that the network cable is intact.
● Re-power on.

SF Blinking Module error Troubleshoot the error.

Note
The fault code information of the communication interface module needs to be read
through UCMM. For details about the parameters read, see "5.2.2 Configuration via
UCMM Programming" on page 29. The following table describes the specific fault
codes, causes, and solutions.



‑62‑

Fault code Cause Solution

0x1000

● Expansion module does not exist
● No expansion module was
scanned due to local bus
communication failure.

● Check that the module is installed
properly and supplied with
power.

● Check the contact of the
communication interface of the
expansion module or restart the
rack.

0x1001 ● The actual slot of the expansion
module is inconsistent with the
configuration.

● Local bus communication failure,
resulting in that the module
scanned is inconsistent with the
configuration.

● Check the number and
installation sequence of
expansion modules.

● Check the contact of the
communication interface of the
expansion module or restart the
rack.

0x1002

0x1003

0x1004 The local bus communication
failure causes an error when the
master module interacts with the
expansion module.

Check the contact of the
communication interface of the
expansion module or restart the
rack.

0x1005

0x1006

● I/O module was powered off or
removed.

● Error was caused by high frame
loss rate of local bus
communication.

● Check whether the module in the
corresponding slot is powered off
or removed.

● Check the contact of the
communication interface of the
expansion module or restart the
rack.

0x5001
Unstable power supply to the
module or power failure

Check the power supply of the
module0x5002

0x5003

0x5011
DAC device temperature is too
high.

● Check whether the module
hardware is faulty.

● Replace the Module.
0x5021 ADC device failure

0x5022 DAC device failure

0x5023 ADC reference voltage error
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Fault code Cause Solution

0x5031 TC module cold end sampling
channel failure

● Check the TC module cold end
channel hardware.

● Replace the module.

0x6001 Analog channel wiring
disconnected

● Check the external wiring of the
module channel.

● If external wiring is correct, it is
recommended to check the
internal hardware of the module
or replace the module.

0x6002 Analog channel wiring shorted

0x6003

Channel data is abnormal and out
of normal range.

Check that the external input signal
of module is normal.

0x6004

0x6005

0x6006

0x6050

For any channel that is outputting,
the chip detects that the output
current exceeds the current limit of
the chip (2.4 A to 3.2 A, typical
value 2.8 A).

Check whether the load is short-
circuited.

0x6051
For any channel that is not
outputting, the chip detects that
the DO is not connected to a load.

Check the load status.

0x6052
For any channel that is outputting,
the chip detects that the DO is not
connected to a load.

0x6053
For any channel that is not
outputting, the chip detects a short
circuit between the DO and VDD.

Check the DO wiring.

0x6054

When the output current is too
large but the overcurrent
protection value is not reached, the
power consumption of the chip's
output channel increases and the
temperature increases.
When the junction temperature
reaches 165℃, an overload error
(high current module) occurs.

Check the load status.
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7 Appendix: Firmware Upgrade
You can upgrade the MCU firmware through the Ethernet interface.

■ Prerequisite
● Get the InoEtnLoader software and the MCU firmware upgrade package.

● The InoEtnloader software has been successfully installed on the local PC.
● The local PC is connected to the communication interface module through a

network cable.

● Ensure that the IP address of the local PC and the IP address of the
communication interface module are on the same network segment.

■ Steps
1. Open the InoEtnLoader software.

Figure 7-1 Opening the software
2. Burn the upgrade firmware.
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a. In the software, select "Network card", "Local IP address", "Communication
Mode". Configure "Station Number" and select "Standard Ethernet Scan", select
the file to be burned, click Scan Device, and then click Burn after the device is
scanned.

Figure 7-2 Programming
The burning is successful.
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Figure 7-3 Programming succeeded
b. Turn off the communication interface module, then turn it on again.
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